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Reguli de aur la introducerea textului:
1.	 ~ntre cuvintele din text se introduce un singur spa]iu (prin ap\sarea tastei de „spa]iu”), 

niciodat\ dou\ sau mai multe.
2.	 Textul se va introduce ̀ n flux continuu, f\r\ a ap\sa tasta Enter pentru a rupe rândurile 

spre marginea dreapt\ a ecranului/documentului. (Ruperea rândurilor se realizeaz\ 
dinamic [i automat de c\tre program `n momentul `n care cursorul dep\[e[te marginea 
paginii logice a documentului.) Tasta Enter se apas\ când se dore[te `nceperea de 
paragrafe/alineate noi.

3.	 Se va introduce un spa]iu dup\ fiecare semn de punctua]ie (.,:;?!) [i niciodat\ 
`nainte (ceea ce va garanta că rândurile de text nu vor începe cu semne rătăcite).

4.	 Parantezele (precum [i ghilimelele) se tip\resc alipite de cuvintele pe care le includ: 
(, ), {, }, [, ], „, ”.

5.	 Alineatele nu se `ncep niciodat\ prin inserarea mai multor caractere de tip spa]iu, ci 
folosind tasta Tab sau un deplasament predefinit.

6.	 Centrarea titlurilor nu se va face interpunând spa]ii sau Tab‑uri, ci folosind func]ia 
de aliniere centrat\ (dac\ programul de editare are o astfel de func]ie).

7.	 Litera majuscul\ de la `nceputul frazelor sau al numelor proprii se ob]ine prin men]inerea 
ap\sat\ a tastei Shift ̀ n timpul introducerii literei dorite. Tasta Caps Lock se recomand\ 
doar când se introduc mai multe litere/cuvinte cu majuscule (titluri).

Defini]ie: Se nume[te paragraf por]iunea de text cuprins\ `ntre dou\ Enter‑uri.

Observa]ie: Enter‑ul introdus `ntr‑un text este un caracter ca oricare altul, adic\ poate fi introdus 
(pentru a insera rânduri noi) sau [ters `n mod obi[nuit. Similar stau lucrurile [i cu Tab.

Selectarea unei por]iuni de text: este o opera]ie evoluat\ la care recurgem c^nd dorim s\ 
ac]ion\m dintr‑o dat\ asupra unui grup mai mare de caractere consecutive pentru:

–	 a le [terge (a `nl\tura por]iunea respectiv\);
–	 a le copia sau a le muta `n alt\ parte a documentului;
–	 a le modifica aparen]a.

Putem selecta un bloc de text prin dou\ metode:

–	 cu tastatura: ]inem ap\sat\ tasta Shift ̀ n timp ce deplas\m cursorul de la o extremitate 
la alta a por]iunii de text pe care dorim s\ o select\m;

–	 cu mouse‑ul: punct\m la un cap\t al por]iunii de selectat [i „tragem” (]inând ap\sat 
butonul mouse‑ului) pân\ ajungem `n cap\tul cel\lalt.

Odat\ ob]inut\ selec]ia, putem ini]ia asupra ei una dintre opera]iile amintite mai sus, 
folosind comanda respectiv\:

–	 pentru [tergere vom ap\sa tasta Delete;
–	 pentru copiere/mutare putem „trage” cu mouse‑ul de por]iunea selectat\ spre o zon\ 

destina]ie (eventual ]inând ap\sat\ tasta Ctrl);
–	 pentru formatare vom folosi una dintre comenzile pe care le vom discuta la subiectul 

urm\tor.

~n orice moment al activit\]ii de editare a textului, vom putea apela comanda Undo (prin 
combina]ia de taste Ctrl+Z sau prin butonul respectiv din „caseta de unelte” a pro‑
gramului) pentru a anula/reface ultima manevr\.
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Level 2

Pentru a lucra (cu) texte [i documente, vom face apel la programe specializate:

•	 editoare de text: programele cu care se creeaz\ [i se modific\ fi[iere de tip text (care 
con]in doar cuvinte [i caractere alfanumerice) [Notepad sub Windows];

•	 procesoare de documente: programe specializate care dispun de comenzi prin care se 
controleaz\ caracteristici referitoare la:
–	 `ncadrarea ̀ n pagin\ (paginarea urm\re[te dimensiunile paginilor fizice [i marginile 

rezervate `ntre text [i muchia hârtiei);
–	 eviden]ierea sau estomparea unor por]iuni de text (titluri, informa]ii importante, 

note auxiliare);
–	 diferite tipuri de aliniere;
–	 organizarea `n tabele, coloane sau `n alte structuri deosebite;
–	 inser]ii de imagini sau de grafic\ (fotografii, ecua]ii matematice, histograme, 

organigrame etc.); [.a.

[Procesoare de documente: Microsoft Word, WordPad; Lotus WordPro, Corel WordPerfect, 
OpenOffice Writer, LibreOffice Writer etc.]

Tastele ac]ionate Semnifica]ie
Deplasarea `n cadrul textului:
s\geat\ stânga/dreapta deplasare cu un caracter la stânga/dreapta
s\geat\ sus/jos deplasare cu un rând `n sus/jos
Home salt la `nceputul rândului curent
End salt la sfâr[itul rândului curent
Page Up salt la pagina anterioar\ (pagina corespunzând deseori paginii de 

afi[are pe ecran, [i nu paginii de document tip\ribil)
Page Down salt la pagina urm\toare
Ctrl + s\geat\ stânga salt la `nceputul cuvântului din stânga pozi]iei curente
Ctrl + s\geat\ dreapta salt la `nceputul cuvântului din dreapta pozi]iei curente
Ctrl + s\geat\ sus salt spre `nceputul paragrafului curent/anterior
Ctrl + s\geat\ sus salt spre sfâr[itul paragrafului curent/anterior
Ctrl + Home salt la `nceputul documentului
Ctrl + End salt la sfâr[itul documentului
{tergerea/inserarea de caractere:
Delete/Del [terge caracterul din dreapta pozi]iei curente (sau din pozi]ia curent\)
Backspace [terge caracterul din stânga pozi]iei curente
Insert •	 activeaz\/dezactiveaz\ modul de scriere cu inser]ie: introdu‑

cerea de caractere `n interiorul unui text existent determin\ 
deplasarea spre dreapta a caracterelor din dreapta cursorului (`n 
cazul suprascrierii, noile caractere s-ar scrie peste cele 
existente)

•	 `n procesorul Microsoft Word tasta poate fi folosit\ pentru a 
insera `n pozi]ia curent\ por]iunea de text memorat\ anterior 
(dac\ se activeaz\ op]iunea-meniu Tools → Options → Use the 
INS key for paste)
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Alte comenzi utile la editare

De la 
tastatur\

Din meniul 
„Edit”

Semnifica]ie

Ctrl+Z Undo refacerea ultimei/ultimelor opera]iuni de editare; foarte 
util\ `n repararea imediat\ a unei gre[eli observate pe loc

Ctrl+Y Redo sau Repeat restabilirea st\rii dinaintea opera]iunii de refacere
Ctrl+F
(sau F3)

Find & Replace permite c\utarea `n cadrul textului a unui [ir de caractere 
[i eventual `nlocuirea sa cu un altul, specificat prin dialog

Comenzi de editare bazate pe folosirea clipboard‑ului
Clipboard‑ul este un fel de memorie logic\ pe care aplicaţiile/programele o pot folosi 
pentru stocarea/memorarea temporar\ a unor informa]ii selectate (text, grafic\ etc.) [i 
pentru manevrarea lor imediat\.

De la 
tastatur\

Din meniul 
„Edit”

Semnifica]ie

Ctrl+C Copy copierea `n clipboard a por]iunii de text selectate
Ctrl+V Paste inserarea, în pozi]ia curent\, a por]iunii de text memorate 

anterior 
Ctrl+X Cut mutarea `n clipboard a por]iunii selectate (memorare + [tergere)
Delete/Del [tergerea por]iunii de text selectate

Procesoarele de documente permit vizualiz\ri la sc\ri diferite (ca [i cum am privi documentul 
mai de aproape sau mai de departe), prin meniul View sau prin butoanele de Zoom.

Notă: Ca alternativă la software-urile de tip „procesor de documente” instalate pe calculatorul utili‑
zatorului, există şi aplicaţii similare accesabile „on-line” prin internet (soluţii „cloud” precum 
Google Docs, Microsoft Office Online, ThinkFree Office). Pe măsură ce va creşte capacitatea 
de trafic a internetului, această abordare „cloud” va cunoaşte o proliferare semnificativă.

Level 3
Chiar dac\ are nuan]e filosofice, este interesant de v\zut de ce lucr\m texte cu ajutorul 
calculatorului. În uzanţa clasică, destina]ia documentului pe care `l edit\m este tip\rirea, 
`ns\ se vorbe[te tot mai des [i despre transmiterea informa]iilor sau publicarea docu
mentelor pe/prin internet. Iar dac\ ne ̀ ntreb\m de ce calculatorul tinde s\ substituie mijloacele 
tradi]ionale de creare [i vehiculare a documentelor, vom g\si dou\ motive esen]iale:

•	 aspectul grafic: se ob]ine relativ u[or un nivel `nalt al calit\]ii grafice (limitele depind 
mai mult de imagina]ia celui care compune documentul decât de performan]ele pro‑
gramelor, calculatoarelor [i imprimantelor actuale);

•	 valoarea de `ntrebuin]are: o dat\ salvat ca fi[ier, documentul respectiv va putea fi 
refolosit oricând, fie pentru a‑l retip\ri/retransmite, fie pentru a‑i prelua câte ceva din 
con]inut la conceperea de alte documente `nrudite.

Superioritatea calculatorului devine indiscutabil\ atunci când este vorba despre documente 
incluzând logic\ (leg\turi automate ̀ ntre por]iuni de documente sau trimiteri la alte documente) 
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sau informa]ie multimedia (sunet, anima]ie, video, grafic\ interactiv\) – a[a cum sunt 
paginile/documentele HTML, XML sau PDF.
Fi[ierele text neformatate se mai numesc [i fi[iere ASCII, dup\ numele codului alfanu‑
meric standard implementat iniţial pe mini‑ [i microcalculatoare.
Cu ajutorul procesoarelor de documente moderne (majoritatea dispunând de o gam\ bogat\ 
de facilit\]i) vom putea ob]ine documente foarte complexe:

–	 cu variate m\rimi [i aspecte ale fonturilor (`n combina]ii practic nelimitate);
–	 texte organizate pe mai multe coloane (inclusiv coloane asimetrice);
–	 incluzând tabele (chiar [i neregulate, unde num\rul de coloane/rânduri nu se p\streaz\ 

constant);
–	 cu inserturi grafice (elemente geometrice precum chenare, linii, cercuri);
–	 incluzând imagini (din fi[iere exterioare);
–	 folosind fundaluri colorate sau umplute cu modele/imagini [.a.

~ns\ atunci când gradul de complexitate cerut documentului este ridicat (fiind necesar\ o 
libertate deosebit\ `n compunerea elementelor documentului) – a[a cum se `ntâmpl\ la 
crearea de reviste, ziare, pliante publicitare etc. –, se va recurge la programe specializate 
pentru DTP44 (Adobe PageMaker, Quark XPress, InDesign, Ventura, Microsoft Publisher).
Procesoarele de documente lucrând sub Windows permit [i gestionarea mai multor ferestre 
(se pot deschide simultan oricâte documente, ceea ce devine util `n situa]ii precum aceea 
`n care dorim s\ citim sau s\ prelu\m informa]ii din alt document decât cel pe care `l 
edit\m).
De asemenea, se pot controla propriet\]i globale ale documentului `n lucru (cum ar fi 
stabilirea limbii – ceea ce ajut\ la verificarea/corectarea textului [i la asocierea corect\ a 
caracterelor cu specific na]ional, sau definirea utilizatorului [i chiar autentificarea sem‑
natarului etc.).

Formatarea de baz[

Level 1
De acum, considerând asimilat\ etapa de editare 
a textelor, vom vorbi despre realizarea de docu
mente – [i vom ̀ ncepe cu posibilitatea de a aplica 
textului urm\toarele atribute45:

•	 fontul – ̀ nseamn\ forma caracterelor (aspectul 
acesta uniform‑distinctiv `ncadreaz\ literele 
`ntr‑unul din fonturile disponibile: Arial, 

44.	DTP = Desktop Publishing (tehnoredactare asistat\ de calculator).
45.	Activarea/dezactivarea acestor atribute se face cel mai simplu punctând cu mouse‑ul pe butoanele 

respective din bara de unelte (toolbar‑ul aflat uzual sub meniul principal).

Word(Pad): Formatting Bar: 
selectarea fontului, m\rimii, aparen]ei
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Times New Roman, Courier, Impact, Lucida, Tahoma, Verdana, Symbol, System 
[.a.46);

•	 m\rimea scrisului – se refer\ la dimensiunea caracterelor (corpul de text normal având 
de obicei m\rimea de 10, 11, 12 sau 14 unit\]i);

•	 aparen]a scrierii (uneori numit\ impropriu stil) – confer\ un aspect deosebit porţiunilor 
de text pe care dorim s\ le eviden]iem:
–	 scris `ngro[at („bold”) [exemplu text de prob\];
–	 scris `nclinat („italic”) [exemplu text de prob\];
–	 scris subliniat („underline”) [exemplu text de prob\];
–	 normal (f\r\ aparen]\ suplimentar\).

•	 alinierea textului dintr‑un paragraf – se refer\ la modul de 
aliniere a textului (pozi]ia pe orizontal\) `n raport cu mar‑
ginile documentului (marginile laterale):
–	 aliniere la stânga (toate rândurile vor `ncepe din mar

ginea stâng\, indiferent de cum vor sfâr[i la dreapta);
–	 aliniere la dreapta (toate rândurile sunt trase astfel `ncât 

s\ sfâr[easc\ la marginea dreapt\, indiferent cum `ncep 
`n stânga);

–	 aliniere central\/centrat\: textul este pus pe mijloc (distan]ele stânga‑dreapta pe 
fiecare rând sunt egale);

–	 aliniere plin\: textul este for]at s\ umple rândul din marginea stâng\ pân\ `n 
marginea dreapt\ (prin mărirea spaţiilor goale dintre cuvinte).

Not\: Aplicarea acestor atribute se poate face fie pe m\sur\ ce introducem textul, fie dup\ ce am 
introdus textul (când le vom aplica selectând por]iunile de text vizate).

Level 2
Deseori ne va fi mai comod (mai ales pentru a nu fragmenta fluxul de introducere a 
textului) s\ stabilim format\rile prin comenzi de la tastatur\ (prin combina]ii de taste):

–	 Ctrl+B – scris `ngro[at (Bold);
–	 Ctrl+I – scris `nclinat (Italic);

46.	Sub Windows pot exista zeci, sute sau chiar mii de fonturi disponibile.

Word(Pad): Formatting 
Bar: selectarea alinierii
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–	 Ctrl+U – scris subliniat (Underline);
–	 Ctrl+L – aliniere la stânga (Left);
–	 Ctrl+R – aliniere la dreapta (Right);
–	 Ctrl+E – aliniere central\ (Center);
–	 Ctrl+J – aliniere plin\ (Justify).

~n afara format\rilor elementare (font, m\rime, aparen]\, aliniere), procesoarele de docu‑
mente evoluate ne vor ajuta [i la chestiuni de genul:

•	 aparen]e deosebite:
–	 superscript: scris sub form\ de exponent [exemplu text de prob\];
–	 subscript: scris sub form\ de indice [exemplu text de prob\];
–	 obliterare: text anulat prin trasarea unei linii orizontale [exemplu text de prob\];
–	 double‑underline: subliniat cu dou\ linii [exemplu text de prob\];

•	 culoare pentru text/scris [i/sau pentru fundal [exemplu text de prob\];
•	 aliniere cu indentare: un deplasament (de la marginea stâng\ sau cea dreapt\) impus 

unui paragraf de text (cu sau f\r\ tratarea special\ a 
deplasamentului pentru primul rând);

•	 bullet: simbol grafic (bulin\, p\tr\]el etc.) sau indice 
(alfabetic, numeric) ce apare la `nceput de paragraf;

•	 numerotarea automat\ a paginilor [i `nscrierea numă
rului de pagin\.

Toate acestea ([i multe altele) le putem aplica pornind 
de la op]iunile din meniul principal al procesorului de 
texte folosit sau prin butoanele toolbar‑ului.
O alt\ facilitate important\ (controlat\ similar, adic\ fie 
prin meniurile View → Zoom..., fie prin butoane dedi
cate, precum Zoom Control din Microsoft Word) se 
refer\ la posibilitatea de a apropia sau dep\rta docu
mentul (altfel zis, de a‑l vedea mai `n detaliu sau `ntr‑o 
perspectiv\ mai larg\). Dac\ a fost activat\ op]iunea-
meniu View → Page Layout – adic\ avem reprezentare WYSIWYG47 –, putem avea un 
control vizual optim al paginii prin op]iuni de genul Whole Page/Full Page, Page Width, 
Margin Width, Optimal.

Level 3
La formatarea textului din documente vom putea aplica şi opţiuni mai puţin frecvente:

•	 scalarea şi spaţierea caracterelor de text;
•	 adăugarea de efecte speciale (animaţii) caracterelor de text;
•	 împărţirea automată în silabe la capăt de rând;
•	 distan]a pe vertical\ dintre rânduri [i paragrafe, care poate fi:

47.	WYSIWYG – What You See Is What You Get = ceea ce vezi (pe ecran) este ceea ce ob]ii (la 
imprimant\); această afi[are este folosită ast\zi de mai toate software‑urile lucrând cu documente.

Zoom Control


